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Product information

IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

The resDNASEQ™ Quantitative DNA Kits are used to quantitate residual DNA from CHO, E. coli,
HEK293, Human, MDCK, NSO, Pichia, Sf9 and Baculovirus, and Vero, or plasmid DNA for Kanamycin
resistance, in cell lines which are used for production of biopharmaceutical products. Use the kit after
you extract host-cell DNA from test samples. For extraction information, see the PrepSEQ™ Sample
Preparation Kits User Guide (Pub. No. 4469838).

The resDNASEQ™ Quantitative DNA Kits use TagMan™ quantitative PCR to perform rapid, specific
quantitation of sub-picogram levels of residual host-cell or plasmid DNA. The assay is accurate and
reliable across a broad range of sample types, from in-process samples to final product.

To generate the standard curve used to quantitate the DNA in test samples, the CHO, MDCK, NSO,
Vero, synthetic Vero, and Plasmid DNA - Kanamycin resistance assays require six dilutions and the E.
coli, HEK293, Human, Pichia, and Sf9 and Baculovirus assays require five dilutions. Control DNA for
standard curve generation is included in the kits. In addition, the kits use an internal positive control
(IPC) to evaluate the performance of each PCR reaction.

IMPORTANT! We are committed to providing an exceptional product experience. Reach out to us for
technical support and product training to help you every step of the way, see “Customer and technical
support” on page 72.
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Chapter 1 Product information

Contents
Contents
Table 1 resDNASEQ™ Quantitative CHO DNA Kit (Cat. No. 4402085)
Contents Amount Storage
resDNASEQ™ CHO Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —-25°C to —15°C before first use, protect from light
2075 mt 2-8°C after first use, protect from light
10X CHO DNA Real-Time PCR Assay Mix 300 pL -25°C to —15°C, protect from light
Negative Control (Water) —25°C to —15°C before first use
1omt 2-8°C after first use

resDNASEQ™ CHO DNA Control

CHO DNA Control, 30 ng/pL 40 pL -25°C to -15°C

DNA Dilution Buffer 7 mL 2-8°C

Table 2 resDNASEQ™ Quantitative E. coli DNA Kit (Cat.

No. 4458435)

Contents Amount Storage
resDNASEQ™ Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light

2> 0.75mb 2-8°C after first use, protect from light
Negative Control (Water) —25°C to —-15°C before first use
1omb 2-8°C after first use

10X E. coli DNA Assay Mix 300 pL —25°C to -15°C, protect from light
resDNASEQ™ E. coli DNA Control
E. coli DNA Control, 30 ng/uL 40 pL -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C
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Table 3 resDNASEQ™ Quantitative HEK293 DNA Kit (Cat. No. A46014)

Contents Amount Storage
resDNASEQ™ HEK293 DNA Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light

2075 mt 2-8°C after first use, protect from light
10X HEK293 Assay Mix 300 pL —25°C to -15°C, protect from light
Negative Control (Water) —25°C to —15°C before first use
1omb 2-8°C after first use

resDNASEQ™ HEK293 DNA Control
HEK293 DNA Control, 30 ng/pL 40 pL -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C

Table 4 resDNASEQ™ Quantitative Human DNA Kit (Cat. No. A26366)

Contents

Amount

Storage

resDNASEQ™ Human Real-Time PCR Reagents

TagMan™ Environmental Master Mix 2.0

2 x0.75mL

—25°C to —15°C before first use, protect from light
2-8°C after first use, protect from light

10X Human DNA Assay Mix 300 pL —25°C to -15°C, protect from light

Negative Control (Water) —25°C to —15°C before first use
1omb 2-8°C after first use

resDNASEQ™ Human DNA Control

Human DNA Control, 30 ng/uL 40 pL -25°C to -15°C

DNA Dilution Buffer 7 mL 2-8°C

Table 5 resDNASEQ™ Quantitative MDCK DNA Kit (Cat.

No. 4464335)

Contents Amount Storage
resDNASEQ™ Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light
2075 mt 2-8°C after first use, protect from light
Negative Control (Water) —25°C to —15°C before first use
1omt 2-8°C after first use
10X MDCK DNA Assay Mix 300 pL —25°C to —15°C, protect from light
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Table 5 resDNASEQ Quantitative MDCK DNA Kit (Cat. No. 4464335) (continued)

Contents Amount Storage
resDNASEQ™ MDCK DNA Control
MDCK DNA Control, 30 ng/uL 40 pL -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C
Table 6 resDNASEQ™ Quantitative NSO DNA Kit (Cat. No. 4458441)
Contents Amount Storage
resDNASEQ™ Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light
2> 0.75mb 2-8°C after first use, protect from light
Negative Control (Water) —25°C to -15°C before first use
1omb 2-8°C after first use
10X NSO DNA Assay Mix 300 pL —25°C to -15°C, protect from light
resDNASEQ™ NSO DNA Control
NSO DNA Control, 30 ng/uL 40 pL -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C
Table 7 resDNASEQ™ Quantitative Pichia DNA Kit (Cat. No. 4464336)
Contents Amount Storage
resDNASEQ™ Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light
2075 mt 2-8°C after first use, protect from light
Negative Control (Water) —25°C to —15°C before first use
1omb 2-8°C after first use
10X Pichia DNA Assay Mix 300 pL —25°C to —15°C, protect from light
resDNASEQ™ Pichia DNA Control
Pichia DNA Control, 30 ng/uL 40 pL -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C
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Table 8 resDNASEQ™ Quantitative Sf9 and Baculovirus DNA Kit (Cat. No. A46066)

Contents Amount Storage
resDNASEQ™ Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light
2075 mt 2-8°C after first use, protect from light
Negative Control (Water) —25°C to —15°C before first use
1omt 2-8°C after first use

10X Sf9 + Baculovirus DNA Assay Mix 300 pL —25°C to —15°C, protect from light
resDNASEQ™ Sf9 and Baculovirus DNA Control
Multiplex DNA Control with:

e Sf9 DNA Control, 30 ng/uL 40 L -25°C to -15°C

e Baculovirus DNA Control, 30 ng/pL
DNA Dilution Buffer 7 mL 2-8°C

Table 9 resDNASEQ™ Quantitative Vero DNA Kit (Cat. No. A41797)

Contents Amount Storage
resDNASEQ™ Real-Time PCR Reagents
TagMan™ Environmental Master Mix 2.0 —25°C to —15°C before first use, protect from light

2x0.75mL
2-8°C after first use, protect from light
Negative Control (Water) —25°C to —15°C before first use
1omb 2-8°C after first use

10X Vero DNA Assay Mix 300 pL —25°C to —15°C, protect from light
resDNASEQ™ Vero DNA Control
Vero DNA Control, 30 ng/uL 40 pL -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C

Table 10 resDNASEQ™ Quantitative Plasmid DNA - Kanamycin Resistance Gene Kit (Cat. No. A50337)

Contents

Amount

Storage

resDNASEQ™ Kanamycin DNA Real-Time PCR Reagents

TagMan™ Environmental Master Mix 3.0

—25°C to —15°C before first use, protect from light

2 x0.75mL
2-8°C after first use, protect from light
10X KanR Assay Mix 300 pL —25°C to —15°C, protect from light
Yeast tRNA (10 mg/mL) 500 L -25°C to -15°C
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Required materials not supplied

Table 10 resDNASEQ Quantitative Plasmid DNA - Kanamycin Resistance Gene Kit (Cat. No.

A50337) (continued)

Contents Amount Storage
Negative Control (Water) —25°C to —15°C before first use
1omb 2-8°C after first use
resDNASEQ™ Kanamycin DNA Control
KanR DNA Control, 3 x 107 copies/pL 44 L -25°C to -15°C
DNA Dilution Buffer 7 mL 2-8°C

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Item

Source

Instrument

QuantStudio™ 5 Real-Time PCR System with AccuSEQ™ Real-Time PCR
Software v3.1 or later

Contact your local sales representative.

Consumables

MicroAmp™ Optical 96-Well Reaction Plate with Barcode, 20 plates,
0.1-mL wells; for use with Applied Biosystems™ 7500 Fast Real-Time PCR
System

4346906

MicroAmp™ 96-Well Base

N8010531, 10 bases

MicroAmp™ Optical Adhesive Film

4311971, 100 covers
4360954, 25 covers

MicroAmp™ Adhesive Film Applicator

4333183, 5 applicators

Miscellaneous items

Disposable gloves

Major lab supplier (MLS)

Pipettes

MLS

Aerosol-resistant micropipette tips

MLS

For the PCR plate: Fisher Scientific™ Mini Plate Spinner Centrifuge, 120-
or 230-volt

14-100-143 (120-volt), 14-100-141
(230-volt)

Nonstick, RNase-free Microfuge Tubes, 1.5 mL (1 box; 250 tubes/box)

AM12450

10
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Workflows

Workflows

Genomic DNA

- Prepare the control serial dilutions page 13

. Prepare the PCR reaction mix page 15

- Prepare the PCR plate page 16

Create a resDNASEQ experiment using the AccuSEQ™ Software v3.1
or later for the QuantStudio™ 5 Instrument page 18

Create a Sf9 and Baculovirus experiment using the AccuSEQ™
Software v3.2 or later for the QuantStudio™ 5 Instrument page 21

Start the run using the AccuSEQ™ Software v3.1 or later page 26

Analyze the results using the AccuSEQ™ Software v3.1 or later
page 45
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Workflows

Plasmid DNA

Prepare the control serial dilutions page 29

Prepare the PCR reaction mix page 31

Prepare the PCR plate page 32

Create a resDNASEQ experiment using the AccuSEQ™ Software v3.1
or later for the QuantStudio™ 5 Instrument page 18

Create a Kanamycin experiment using the AccuSEQ™ Software v3.2
or later for the QuantStudio™ 5 Instrument page 38

Start the run using the AccuSEQ™ Software v3.1 or later page 26

Analyze the results using the AccuSEQ™ Software v3.1 or later
page 45
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Genomic DNA gquantitation

Prepare the control DNA serial dilutions for the standard
curve

Guidelines for standard dilutions

* Prepare the standard curve and the test samples in different areas of the lab.

* Use different sets of pipettors for test sample preparation and for standard curve preparation and
aliquoting to avoid cross-contamination of test samples.

* Vortex each tube to mix the contents thoroughly before each dilution step.
* Briefly centrifuge to collect all the liquid at the bottom before making the next dilution.

Prepare the control serial dilutions (Genomic DNA)

1. Label nonstick 1.5-mL microfuge tubes: NTC, SD1, SD2, SD3, SD4, SD5.
For CHO, Vero, MDCK, and NSO kits, label an additional tube with SD6.

2. Add 50 pL of DNA Dilution Buffer to tube NTC. Put aside.
3. Add 990 uL of DNA Dilution Buffer to tube SD1.

4. Add 450 pL of DNA Dilution Buffer to tubes SD2, SD3, SD4, SD5, and (for CHO, Vero, MDCK, and
NSO only) SD6.

5. Remove the tube of DNA control (30 ng/uL) from the freezer.
6. After the DNA thaws, vortex it gently for 2 seconds, then briefly centrifuge.

7. Perform the serial dilutions:

a. Add 10 pL of the DNA control to the tube that is labeled SD1, then vortex thoroughly and
briefly centrifuge.

b. Transfer 50 pL of the DNA from tube SD1 to tube SD2, then vortex thoroughly and briefly
centrifuge.

resDNASEQ™ Quantitative DNA Kits User Guide 13
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Chapter 2 Genomic DNA quantitation
Prepare the control DNA serial dilutions for the standard curve

c. Continue to transfer 50 pL of DNA from the previous dilution tube to the next dilution tube until
you add DNA to tube SD5 (E. coli, HEK293, Human, Pichia, and Sf9 and Baculovirus) or SD6
(CHO, Vero, MDCK, and NSQ). Final dilutions are shown in the table. After each transfer, vortex
thoroughly, then centrifuge briefly.

Serial dilution (SD) tube

Dilution

pg DNA/reaction (10 pL of the
diluted DNA used in final 30 pL
of PCR reaction)

and NSO only)

Control DNA control tube 300,000 pg
SD 1 10 pyL DNA control + 990 uL DDB 3,000 pg
SD2 50 pL SD1 + 450 uL DDB 300 pg
SD3 50 pL SD2 + 450 uL DDB 30 pg
SD 4 50 pL SD3 + 450 uL DDB 3 pg
SD5 50 pL SD4 + 450 uL DDB 0.3 pg
SD 6 (for CHO, Vero, MDCK, 50 pL SD5 + 450 uL DDB 0.03 pg

8. Store the DNA dilution tubes:

Temperature For use
4°C Same day
—20°C <1 week
-20°C SD1 in single-use aliquots <6 months

resDNASEQ™ Quantitative DNA Kits User Guide



Prepare the PCR reaction mix

Chapter 2 Genomic DNA quantitation ~ [&1
Prepare the PCR reaction mix

1. Determine the number of reactions needed for the controls and test samples that you will quantify.

2. Thaw all kit reagents completely at room temperature, thoroughly mix reagents, and briefly

centrifuge.

3. Prepare a PCR reaction mix using the reagents and volumes shown in the table below.
* Multiply the PCR reaction volume for one reaction (30 pL) by the number of reactions that you

need to run.

* Use 10% excess volume to compensate for pipetting losses.

Note: Use reagents from the same lot for all reactions.

Kit reagents

Volume for 1
30-pL reaction

Volume for 36 30-pL
reactions (includes 10%

overage)
Negative Control (Water) 2 uL 79.2 uL
10X DNA assay mix appropriate for the cell line 3 uL 118.8 pL
being tested
TagMan™ Environmental Master Mix 2.0 15 L 594 L
DNA template 10 yL Add DNA template to each
well separately, not as part
of Master Mix
Total 30 uL 792 uL of Master Mix

resDNASEQ™ Quantitative DNA Kits User Guide
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Prepare the PCR plate

Prepare the PCR plate

Plate setup differs slightly for each AccuSEQ™ System. See your software user guide for specific
instructions. Place samples, NTCs, and standards in different quadrants of the plate.

A factory default template is available for the Quantitative Sf9 and Baculovirus DNA in AccuSEQ™
Real-Time PCR Software v3.2 or later.

7

7
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Figure 1 Quantitative Sf9 and Baculovirus DNA template default sample plate layout in AccuSEQ™ Real-Time
PCR Software v3.2 or later

(@) Toolbar (in order: D Undo, C Redo, (#] Copy, I Paste, Q Delete, @View)
@ Select Item to highlight (Sample, Target, or Task).

Note:
@ Select Item. For example, Sample 1. Sample 1 replicates are highlighted.

If more samples are added, the Target displays as an S in the wells (experiment type—-Quantitation).

Table 11 Quantitative Sf9 and Baculovirus DNA template plate well descriptions in AccuSEQ™
Real-Time PCR Software v3.2 or later

Name Description

SC1 to SC6 Standard curve dilutions in triplicate

Matrix 24 samples in triplicate

NTC No template control in triplicate
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Prepare the PCR plate

1 2 3 4 5 6 T & E] 10 1 12
NTC B NTC B | NTC ] sToacgo ™  sTD 3000 @ | STD 3000 @
@_ A | Me_=x | [We."x | [[e._"x Ble..== | Ble.."= [Ee..==
P o P ox P mx 3000 3000 3000
= = = We.m= | @e."x  @e."=
STD 300 STD 300 5TD 300
& Ble..== | Ble.."= [Ee..==
300 300 300
We..m= | @we."x @
STD30 ® sTpag W™ sTD3o W
e Ble.."= | Ble.."x [BEe.."= _®
30 30 30
Wie. == | @ie.x | WP
STD3 5TD3 STD 3
o Ble.."= | Ele.."x [Ee.."=
3 3 3
We. == | @e.=x  We. "=
TS1 B 751 B 7151 L] sToo3: ® sTDos M sTpos W
e Me.."= | Me.."x | [le.."x Ble..= | Ble.."= [Ele.."=
P "% P "= 1P, "% 0300 0300 0300
@ = = We. == | @e.=x  @e. "=
TS2 B 152 m 182 u
@_ g Me_=x | [Me. "= [le_"x
W= | Wwe.=x | B{we.=x
TS3 B 153 B 153 u
e Me.== | [le. < Me."
W= | Wwe."x | @{e."x
H

Figure 2 Default plate setup in the resDNA_5Std template in AccuSEQ™ Real-Time PCR Software v3.1 or later

@ No template controls

@ Samples
@ Standard curve

1.

2.

Add 20 pL PCR reaction mix to each well.
Add 10 pL of PCR NTC to the appropriate wells.

Add 10 pL each of extracted sample DNA to the appropriate wells.

Note: If you prepared samples with the automated protocol, use a multichannel pipette to transfer
the extracted sample.

Add 10 pL of standard dilutions to the appropriate wells.

Note: Use different sets of pipettors to dispense test sample and standard curve dilutions to avoid
cross-contamination of test samples.

Use a film applicator to seal the plate with optical film, then briefly centrifuge with a miniplate
centrifuge that is compatible with 96-well plates.
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

Setup, run, and analyze samples with AccuSEQ™ Software
on the QuantStudio™ 5 Real-Time PCR Instrument

Create a resDNASEQ™ experiment

1. In the A Home screen, click the Factory default/Admin Defined Template tab, then select a
resDNASEQ_5std or resDNASEQ_6std template.

Note: AccuSEQ™ Software v3.2 or later has a Factory default/Admin Defined Template for the
Quantitative Sf9 and Baculovirus DNA Assay, see “Create a Quantitative Sf9 and Baculovirus DNA
experiment” on page 21.

To navigate to through the available templates click the arrows to either side of the available
templates.

Create New Experiment

— ®
ﬁ Factory default/Admin Defined . My Templates + Create New
Templates
O ViralSEQ MMV Dete... ViralSEQ Vesivirus ... MycoSEQ Plus Myc... ViralSEQ Quantitativ... Quantitative Kanam... @
Serial Dilutions (Standards) Template Assays
5 _5Std E. coli, HEK293, Human, Pichia
6 _6Std CHO, Vero, MDCK, NSO

2. In the Experiment Properties pane of the Setup tab:
a. (Optional) Change the system-generated name of the experiment.

b. (Optional) Enter the plate Barcode, then add Comments.
Default resDNASEQ™ settings (cannot be changed)
¢ Experiment Type is Quantitation-Standard Curve
¢ Chemistry is TagMan™ Reagents
e Ramp Speed is Standard - 2hrs

c. Click Next.

Note: Experiment names cannot be changed after this step.
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

3. In the gPCR Method pane of the Setup tab, view the default volume and cycling conditions
(cannot be changed).

Hold Stage PCR Stage
95 °C 95 °C
1.6 “C/S
10:00 00:15 .
_ N 106-2C/S
ATy 2 N\ -
1.6 5C/S - 60 °C
4 01:00
2 ()
Step 1 Step 1 Step 2
40x

Figure 3 resDNASEQ™ template default cycling conditions

4. Click Next.

5. In the Samples pane of the Setup tab, enter the sample Name and Dilution. Sample Volume is
not needed. Add more Samples if needed.

IMPORTANT! Do not change the Targets.

(1)—Samples (24) Add
Color Name = Dilution Sample Volume
1A 100 o s

] 1B 1.00 0.00

@ Samples pane
@ Add—adds more samples
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Chapter 2 Genomic DNA quantitation
Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

6. In the Samples pane of the Setup tab, scroll to the right, then enter the spike information.

For more information about plate setup, see the AccuSEQ™ Real-Time PCR Software v3.2 User
Guide (Pub. No. MAN0029199).

Sample Volume —not needed; leave as default (0).
Spike Volume —volume of DNA added to the PCR (set to 10).

Spike Standard Concentration—expected spike amount per reaction (for example,
10 pg/reaction or 30 copies/reaction).

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

Spike Input—automatically calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected pg spike per PCR reaction.

(Optional) Comments

Protein Concentration —Sample protein concentration (if Total DNA in pg DNA/mg Protein is
needed).

Samples (24) Add

Spike Volume Spike Standard Concentratior

(H—o0 - 0.00

0.00 0.00
0.00 0.00
0.00 0.00

@— »

@ Textbox—type in the value, or use the up and down arrows

@ Scroll bar—scroll to find the spike parameter

7. Click Next.
The Run tab is displayed.

8. Experiments are auto-saved in the software. To save, exit the experiment. The software prompts
you to save changes. Click Yes.

Note: Clicking B Save As creates a copy of the experiment.

9. (Optional) Click "= Print to print the plate layout for use in preparing the reactions.
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

Create a Quantitative Sf9 and Baculovirus DNA experiment

Note: The Quantitative Sf9 and Baculovirus DNA template is available with AccuSEQ™ Software v3.2
or later.

1. Inthe /A Home screen, click the Factory default/Admin Defined Template tab, then select a
Quantitative Sf9 and Baculovirus DNA template.

To navigate to through the available templates click the arrows to either side of the available
templates.

Create New Experiment

P .
ﬁ Factory default/Admin Defined . My Templates I Create New

Templates

O ViralSEQ MMV Dete... ViralSEQ Vesivirus ... MycoSEQ Plus Myc... ViralSEQ Quantitativ... Quantitative Kanam... @

2. In the Experiment Properties pane of the Setup screen:
a. (Optional) Change the system-generated name of the experiment.

Note: Names must be unique. Deleted experiment names can not be reused.

b. (Optional) Enter the plate barcode in the Barcode field, then add comments in the Comments
field.

Note: Comments are not editable post analysis.

Default Quantitative Sf9 and Baculovirus DNA settings (cannot be changed)
* Experiment Type —Quantitation-Standard Curve
¢ Chemistry—TagMan™ Reagents
e Ramp Speed—Standard - 2hrs

c. Click Next.

Note: Experiment names cannot be changed after this step.
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

3. In the gPCR Method pane of the Setup screen, view the default volume and cycling conditions
(cannot be changed).
Hold Stage PCR Stage
895°C 85°C
1.6 °C/S
y 10:00 0015 1B.°C/S
e 2 N -
1.6 5C/S 60 "L
' 01:00
2
Step 1 Step 1 Step 2
40x
Figure 4 Quantitative Sf9 and Baculovirus DNA template default cycling conditions
4. Click Next.
5. In the Samples table in the Plate Setup pane, enter the sample name and the sample dilution.

Sample volume is not needed. Click Add to add more samples if needed.

IMPORTANT! Do not change the Targets.

(1)—Samples (24) Add

Color Name = Dilution Sample Volume
1A 100 o .
[ | 1B 1.00 0.00

(1) samples table
@ Add—adds more samples

22
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

6. In the Samples table of the Plate Setup pane, scroll to the right, then enter the spike information.

For more information about plate setup, see AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).

Sample Volume —not needed; leave as default (0).
Spike Volume —volume of DNA added to the PCR (set to 10).
Spike Standard Concentration—expected spike amount per reaction (for example, 10 pg).

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

Spike Input—calculated (double check if correct).

Note: If not correct, ensure Spike Volume value is set to 10 and Spike Standard
Concentration value is the expected pg spike per PCR reaction.

(Optional) Comments

Protein Concentration—Drug substance protein concentration (if Total DNA in
pg DNA/mg Protein is needed).

Note: The software calculates the pg of DNA in the initial sample and the percentage of recovered
DNA

Samples (24) Add

Spike Volume Spike Standard Concentratior

(H—o = 0.00

0.00 0.00
0.00 0.00
0.00 0.00

O— '

@ Textbox—type in the value, or use the up and down arrows

@ Scroll bar—scroll to find the spike parameter
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| £ Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument
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Figure 5 Quantitative Sf9 and Baculovirus DNA template default sample plate layout

(D Toolbar (in order: D Undo, C Redo, (7] Copy, I Paste, € Delete, @View)

@ Select Item to highlight (Sample, Target, or Task).

Note: If more samples are added, the Target displays as an S in the wells (experiment type-Quantitation).

@ Select Item. For example, Sample 1. Sample 1 replicates are highlighted.

Table 12 Plate well descriptions
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Name

Description

SC1 to SC6 Standard curve dilutions in triplicate

Matrix 24 samples in triplicate

NTC No template control in triplicate
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7. (Optional) Double-click wells to add comments. Comments can also be added post-analysis.

Comments

B Samples B Samplein W

8. Click Next.
The Run screen is displayed.

9. Experiments are auto-saved in the software. To save, exit the experiment. The software prompts
you to save changes. Click Yes.

Note: Clicking B Save As creates a copy of the experiment.

10. (Optional) Click "= Print to print the plate layout for use in preparing the reactions.

11. Assemble the PCR reactions using the instructions in this guide.
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

Start the run

Start the run in the AccuSEQ™ Software.

Option

Description

If the experiment is open

Click Start Run.

If the experiment is closed

o

Open the experiment.
Click the Run tab.
Click Start Run.

12
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A message stating Run has been started successfully is displayed when the run has started.
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Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

Analyze the results

After the gPCR run is finished, use the following general procedure to analyze the results.
For more detailed instructions see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide

(Pub. No. MAN0029199).

1. In the AccuSEQ™ Real-Time PCR Software, open the experiment, then navigate to the Result tab.

AccuSEQ” C?

/ﬁ\ Setup Run Result Report Audit & E-Sign

Experiment Name : 2019-09-23_6503_CHO_ResDNA_QS5-1 E-Sign Status : Unsigned

Result Summary Result Analysis

Plots & Summary

= N E

(D Result tab

@ Analysis Settings button
(3 Plot horizontal scrollbar
@ Analyze button

Amplification Multicomponent Raw Data Standard Curve Q¢ Sum
*To o [# (@) o (o))
Amplification Plot
e
4

7

£} Analysis Settings Save As Save As Template  [3» Export Experiment

Assay Name : ResDNA_65td

Results
Sample v =
1 2 3 a s s E s a 10 n 12
WG W [wTcE  NTCH STD® | sTOE SO ®
AlEs B B E- E- B-
20 | - | a0
cr cr cr Ccr cr
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B |2 3 2 B BT BH-
. . . 20| ;e ;0
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2. In the Result Analysis tab, review the Amplification Curve plots for amplification profiles in the

controls, samples, and the standard curve.

3. In the Result Analysis tab, review the QC Summary for any flags in wells.
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4. In the Result Analysis tab, review the Standard Curve plot. Verify the values for the Slope,
Y-intercept, R2, and Efficiency.

Note: The Standard Curve efficiency should be between 90-110% and the R2>0.99. If these
criteria are not met, up to two points, not in the same triplicate, can be removed from the standard
curve data, and the analysis repeated.

5. (Optional) Navigate to the Report tab to generate a report of the experiment, or to export results.

28 resDNASEQ™ Quantitative DNA Kits User Guide



Plasmid DNA quantitation

Sample residual plasmid DNA is measured in copy number, not concentration. To manually convert
the copy number output to a mass measurement, multiply the copy number given by the AccuSEQ™
Real-Time PCR Software to the average molecular weight of your plasmid.

Prepare the control DNA serial dilutions for the standard

curve

Guidelines for standard dilutions

Prepare the standard curve and the test samples in different areas of the lab.

Use different sets of pipettors for test sample preparation and for standard curve preparation and
aliquoting to avoid cross-contamination of test samples.

Vortex each tube for 15-30 seconds to mix the contents thoroughly before each dilution step.

Vortex for 15-30 seconds, then tap down standards, before adding the standards to the PCR plate
(plasmid standards are more fragile than genomic DNA standards).

Prepare the control serial dilutions (Plasmid DNA - Kanamycin Resistance)

1.

Label nonstick 1.5-mL microfuge tubes: NTC, SD1, SD2, SD3, SD4, SD5, and SD6.

The dilution SD6 will not be used for the standard curve. It will be used to confirm the limit of
detection (LOD).

Add 70 pL of DNA Dilution Buffer to tube NTC. Put aside.

Add 990 pL of DNA Dilution Buffer to tube Dilution 1.

Add 180 pL of DNA Dilution Buffer to tubes SD1, SD2, SD3, SD4, and SD5.
Add 100 pL of DNA Dilution Buffer to tube SD6.

Remove the tube of KanR DNA control (3.0 x 107 copies/uL) from the freezer.

After the DNA thaws, vortex it thoroughly for 15-30 seconds, then tap gently to bring contents to
the bottom of the tube. Do not centrifuge.

Perform the serial dilutions:
a. Add 10 pL of the KanR DNA control (3.0 x 107 copies/yL) to the tube that is labeled Dilution
1, vortex thoroughly for 15-30 seconds, then tap gently to bring contents to the bottom of the
tube.
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b. Transfer 20 pL of the DNA from tube Dilution 1 to tube SD1, vortex thoroughly for 15-30
seconds, then tap gently to bring contents to the bottom of the tube..

c. Continue to transfer 20 pyL of DNA from the previous dilution tube to the next dilution tube until
you add DNA to tube SD5.

d. Transfer 100 pL of DNA from SD5 to SD6, then vortex thoroughly. Final dilutions are shown
in the table. After each transfer, vortex thoroughly for 15-30 seconds, then tap gently to bring
contents to the bottom of the tube. Do not centrifuge.

Serial dilution (SD) Dilution Concentration (copy Copy number/
tube number/ pL) PCR reaction
Control DNA control tube 3.0x 107 N/A
Dilution 1 10 pL DNA control + 990 pL 300,000 N/A
DDB
SD 1 20 pL Dilution 1 + 180 uL DDB 30,000 300,000
Sh 2 20 pyL SD1 + 180 pL DDB 3,000 30,000
SD3 20 yL SD2 + 180 yL DDB 300 3,000
SD 4 20 pL SD3 + 180 pL DDB 30 300
SD5 20 pL SD4 + 180 pL DDB 3 30
SD 6 (LOD) 100 pL SD5 + 100 pL DDB 1.5 15
9. Store the DNA dilution tubes:
Temperature For use
4°C <2 days
-20°C Dilution 1 <1 week
-20°C Dilution 1 in single-use aliquots <6 months
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Prepare the samples (Kanamycin resistance assay only)

Prepare the samples (Kanamycin resistance assay only)

Extract samples with the PrepSEQ™ Residual DNA Sample Preparation Kit (Cat. No. 4413686).

(Recommended) Use Yeast tRNA, supplied in the PrepSEQ™ Residual DNA Sample Preparation Kit
or the resDNASEQ™ Quantitative Plasmid DNA - Kanamycin Resistance Gene Kit for the kanamycin

resistance and assay.
1. Dilute the Yeast tRNA.

Table 13 Diluted Yeast tRNA

Component Volume
Yeast tRNA (10mg/mL) 5puL
PBS (1X), pH 7.2 245 L
Total 250 pL

2. Add 5 pL Diluted Yeast tRNA to 370 pL of each test sample. This is sufficient for triplicate 100 pL

extractions.

Prepare the PCR reaction mix

1. Determine the number of reactions needed for the controls and test samples that you will quantify.

2. Thaw all kit reagents completely at room temperature, thoroughly mix reagents, and briefly

centrifuge.

3. Prepare a PCR reaction mix using the reagents and volumes shown in the table below.
* Multiply the PCR reaction volume for one reaction (30 pL) by the number of reactions that you

need to run.

* Use 10% excess volume to compensate for pipetting losses.

Note: Use reagents from the same lot for all reactions.

Kit reagents

Volume for 1
30-pL reaction

Volume for 48 30-pL
reactions (includes 10%

overage)
Negative Control (Water) 2L 106 pL
10X DNA assay mix appropriate for the cell line 3L 159 pL
being tested
TagMan™ Environmental Master Mix 2.0 15 uL 795 pL
DNA template 10 yL Add DNA template to each
well separately, not as part
of Master Mix
Total 30 uL 1060 pL of Master Mix
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Prepare the PCR plate

5% Chapter 3 Plasmid DNA quantitation

Prepare the PCR plate

Plate setup differs slightly for each AccuSEQ™ System. See your software user guide for specific
instructions. Place samples, NTCs, and standards in different quadrants of the plate.

A factory default template is available for the Quantitative Kanamycin Assay in AccuSEQ™ Real-Time
PCR Software v3.2 or later.

®_ ‘ |i.°‘|@v| Salacllhfn?
1 2 3

sc1 s61 sG1

A | [Blkan "= Blxan ®x Elkan "x

3.0000E+5 3.0000E+5 3.0000E+5
PC "= PC "= Wiec "=
sc2 u |sc2 LIE- -

B | [Ekan "x EBlxan "= Blxen "=
3.0000E+4 3.0000E+4 3.0000E+4
Wirc == Wirc == Wiec "=

563 m se3 m 53

¢ | [Elkan "= Elxan "x Blxan "=
3.0000E+3 3.0000E+3 3.0000E+3
Wliee == Wipe == Wiec ==

5Ca LINE- ! LIE- -]

D | [Elkan =x Elxan =x Blxan
300.0000 300.0000 300.0000
Wiee == Wipe "= Wiec "=
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Figure 6 Quantitative Kanamycin template default sample plate layout in AccuSEQ™ Real-Time PCR Software

v3.2 or later

(@) Toolbar (in order: D Undo, C Redo, (7] Copy, I Paste, Q Delete, @View)
@ Select Item to highlight (Sample, Target, or Task).

Note: If more samples are added, the Target displays as an S in the wells (experiment type—Quantitation).

@ Select Item. For example, Sample 1. Sample 1 replicates are highlighted.

Table 14 Plate well descriptions for Quantitative Kanamycin template in AccuSEQ™ Real-Time PCR

Software v3.2 or later

Name

Description

SC1 to SC6

Standard curve dilutions in triplicate

X1 to X3, D1 to D4

24 samples in triplicate

NTC

No template control in triplicate
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Figure 7 Default plate setup in the resDNA_5Std template in AccuSEQ™ Real-Time PCR Software v3.1

(D No template controls

@ Samples
(3 Standard curve

1. Add 20 pL PCR reaction mix to each well.
2. Add 10 pL of PCR NTC to the appropriate wells.

3. Add 10 pL each of sample DNA (with tRNA added) to the appropriate wells.

IMPORTANT! Vortex samples for 15-30 seconds before adding the samples to the PCR Plate,
then tap to bring contents to the bottom of the wells.

If you prepared samples with the automated protocol, use a multichannel pipette to transfer the
extracted sample.

4. Add 10 pL of standard dilutions to the appropriate wells.

IMPORTANT! Vortex samples for 15-30 seconds before adding the samples to the PCR Plate,
then tap to bring contents to the bottom of the wells.

If you prepared samples with the automated protocol, use a multichannel pipette to transfer the
extracted sample.

5. Use a film applicator to seal the plate with optical film, then briefly centrifuge with a miniplate
centrifuge that is compatible with 96-well plates.
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Setup, run, and analyze samples with AccuSEQ™ Software
on the QuantStudio™ 5 Real-Time PCR Instrument

Create a resDNASEQ™ template (Plasmid DNA)

Plasmid DNA resDNASEQ™ assays in AccuSEQ™ Software v3.1 do not use a Factory default/Admin
Defined Template. Create a new template before the first use of these assays.

Note: AccuSEQ™ Software v3.2 or later has a Factory default/Admin Defined Template for the
Quantitative Kanamycin Assay, see “Create a Quantitative Kanamycin experiment” on page 38.

1. Inthe A Home screen, click [& Templates in the left navigation pane.
B> import Template
Templates | 6 Templates Actions v a Clear Filter
Template Name < Template Location Publish Created Date < Created By User Modified Date = Modified By User Actions
2018-11-14_ProA 2020-06-03-... My Template 03 Jun 2020 20:01:23 GMT-0500 Administrator 03 Jun 2020 20:01:46 GMT-0500 Administrator + & ®
MycoSEQ Factory Default 01 Jun 2020 06:44:57 GMT-0500 system 01 Jun 2020 06:44:57 GMT-0500 system + E[
ResDNA_5S5td Factory Default 01 Jun 2020 06:44:57 GMT-0500 system 01 Jun 2020 06:44:57 GMT-0500 system + E[
ProteinSEQ HCP Factory Default 01 Jun 2020 06:44:57 GMT-0500 system 01 Jun 2020 06:44:57 GMT-0500 system + Q
ProteinSEQ Pro A Factory Default 01 Jun 2020 06:44:57 GMT-0500 system 01 Jun 2020 06:44:57 GMT-0500 system + L[
ResDNA_6Std Factory Default 01 Jun 2020 06:44:57 GMT-0500 system 01 Jun 2020 06:44:57 GMT-0500 system + Q

() Templates icon

34

2.

3.

Click 4+ Create New next to the ResDNA_5Std factory default template.
Click Next to move to the qPCR Method screen.
Click Next to move to the Plate Setup screen.

In the Plate Setup screen, add the Targets and Reporters.

Targets (2) Add

Color Name = Reporter Quencher Task Qua ¢
?
| Kan FAM NFQ-MGB
| IPC NED NFQ-MGB

For the resDNASEQ™ Quantitative Plasmid DNA - Kanamycin Resistance Gene Kit, this is the FAM™ dye for the
kanamycin (Kan) target and the NED™ dye for the IPC.

Click Save as Template.

Enter a Template Name and description, then select Admin Defined and Locked. Click Save.

The template is saved, and can be accessed from [ Templates in the A Home screen.
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8. Click [@ Templates in the /A Home screen, then open the new template.

Note: The template must be saved prior to editing the £# Analysis Settings

9. Click ¥ Analysis Settings, then deselect Default Settings.

10. Enter new thresholds for the targets.

Table 15 resDNASEQ™ Quantitative Plasmid DNA - Kanamycin Resistance Gene Kit

Target Threshold
Kanamycin 0.04
IPC 0.02

11. Click Apply, then close the template.

12. In the A Home screen, click [& Templates in the left navigation pane, then Publish the template.
See AccuSEQ™ Real-Time PCR Software v3.1 User Guide (Pub. No. 100094287).
The template is listed in the Factory default/Admin Defined Templates.

Create a resDNASEQ™ experiment (Plasmid DNA)

Plasmid DNA resDNASEQ™ assays in AccuSEQ™ Software v3.1 do not use a Factory default/Admin
Defined Template. Create a new template before the first use of these assays.

Note: AccuSEQ™ Software v3.2 or later has a Factory default/Admin Defined Template for the
Quantitative Kanamycin Assay, see “Create a Quantitative Kanamycin experiment” on page 38.

1. In the /A Home screen, click Factory default/Admin Defined Templates, then select the custom
plasmid DNA resDNASEQ template created in “Create a resDNASEQ™ template (Plasmid DNA)”
on page 34.

Note: To create an experiment from an existing resDNASEQ™ experiment, see AccuSEQ™
Real-Time PCR Software v3.1 User Guide (Pub. No. 100094287).

2. In the Experiment Properties pane of the Setup tab:
a. (Optional) Change the system-generated name of the experiment.

Note: Names must be unique. Deleted experiment names can not be reused.

b. (Optional) Enter the plate Barcode, then add Comments.

Note: Comments are not editable post analysis.

Default resDNASEQ™ settings (cannot be changed)
* Experiment Type is Quantitation-Standard Curve
¢ Chemistry is TagMan™ Reagents
* Ramp Speed is Standard - 2hrs

resDNASEQ™ Quantitative DNA Kits User Guide 35



5% Chapter 3 Plasmid DNA quantitation
Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

c. Click Next.

Note: Experiment names cannot be changed after this step.

3. In the gPCR Method pane of the Setup tab, view the default volume and cycling conditions
(cannot be changed).

Hold Stage PCR Stage
95 °C 95 °C
1.6 "C/S
10:00 00:15
y N 106-2C/S
. £ in . ——
1.6 %C/S o
01:00
-3 0|
Step 1 Step 1 Step 2
40x

Figure 8 resDNASEQ™ template default cycling conditions
4. Click Next.

5. In the Samples pane of the Setup tab, enter the sample Name and Dilution. Sample Volume is
not needed. Add more Samples if needed.

IMPORTANT! Do not change the Targets.

(1)—Samples (24) Add

Color Name = Dilution Sample Volume
1A 100 o .

] 1B 1.00 0.00

@ Samples pane
@ Add—adds more samples
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6. In the Samples pane of the Setup tab, scroll to the right, then enter the spike information.

For more information about plate setup, see AccuSEQ™ Real-Time PCR Software v3.1 User Guide

(Pub. No. 100094287).

Sample Volume —not needed; leave as default (0).

Spike Volume —volume of DNA added to the PCR (set to 10).
Spike Standard Concentration—expected spike amount per reaction.

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

Spike Input—automatically calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is

the expected pg spike per PCR reaction.

(Optional) Comments

Protein Concentration—Drug substance protein concentration (if Total DNA in pg DNA/mg

Protein is needed).

Samples (24) Add

Spike Volume

O

0.00

0.00

0.00

@—

@ Textbox—type in the value, or use the up and down arrows
@ Scroll bar—scroll to find the spike parameter

Spike Standard Concentratiol

0.00

0.00

0.00

0.00

3

For more information about plate setup, see AccuSEQ™ Real-Time PCR Software v3.1 User Guide

(Pub. No. 100094287).
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E-Sign Status : Unsigned | Assay Name : ResDNA_55td
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@_
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Figure 9 resDNASEQ™_5Std template default sample plate layout

(1) Toolbar (in order: D Undo, C Redo, (7] Copy, I Paste, ° Delete, @View)
@ 3 No Template Control (NTC) samples

(3 3 default Samples

@ Standard curve dilutions (S) in triplicate

7.

10.

Click Next.
The Run tab is displayed.

Experiments are auto-saved in the software. To save, exit the experiment. The software prompts
you to save changes. Click Yes.

Note: Clicking B Save As will create a copy of the experiment.

(Optional) Click "= Print to print the plate layout for use in preparing the reactions.

Assemble the PCR reactions using the manufacturer's instructions for the reagents and following
the plate layout set up in the template.

Create a Quantitative Kanamycin experiment

38

Note: The Quantitative Kanamycin template is available with AccuSEQ™ Software v3.2 or later.

1.

In the A Home screen, click the Factory default/Admin Defined Template tab, then select a
Quantitative Kanamycin template.

To navigate to through the available templates click the arrows to either side of the available
templates.
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Create New Experiment

— ®
ﬁ Factory default/Admin Defined . My Templates + Create New
Templates
O ViralSEQ MMV Dete... ViralSEQ Vesivirus ... MycoSEQ Plus Myc... ViralSEQ Quantitativ... Quantitative Kanam... @

2. In the Experiment Properties pane of the Setup screen:
a. (Optional) Change the system-generated name of the experiment.

Note: Names must be unique. Deleted experiment names can not be reused.

b. (Optional) Enter the plate barcode in the Barcode field, then add comments in the Comments
field.

Note: Comments are not editable post analysis.

Default Quantitative Kanamycin settings (cannot be changed)
* Experiment Type —Quantitation-Standard Curve
* Chemistry—TagMan™ Reagents
* Ramp Speed—Standard - 2hrs

c. Click Next.

Note: Experiment names cannot be changed after this step.
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3. In the gPCR Method pane of the Setup screen, view the default volume and cycling conditions
(cannot be changed).

Hold Stage PCR Stage
895°C 85°C
1.6 "C/S
/ 10:00 00:15
) ' 16.°C/S
, o o S —
1.6 5C/S 60 °C
01:00
2
Step 1 Step 1 Step 2
40x

Figure 10 Quantitative Kanamycin template default cycling conditions

4. Click Next.

5. In the Targets table of the Plate Setup pane, enter the molecular weight (g/mol) of the targets.
Targets (2) Add

€ Quantity Molecular Weight (g/mol)

o 2]

-

0.0000
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6. In the Samples table in the Plate Setup pane, enter the sample name and the sample dilution.
Sample volume is not needed. Click Add to add more samples if needed.

(1)—Samples (24) Add

Color Name = Dilution Sample Volume
1A 1.00 ]

&
-

] 1B 1.00 0.00

(1) samples pane
@ Add—adds more samples

7. Inthe Samples table in the Plate Setup pane, scroll to the right, then enter the spike information.

For more information about plate setup, see AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).

Sample Volume —not needed; leave as default (0).
Spike Volume —volume of DNA added to the PCR (set to 10).

Spike Standard Concentration—expected spike amount per reaction (for example,
10 copies).

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

Spike Input—calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected copies spike per PCR reaction.

Protein Concentration —Drug substance protein concentration (if total DNA in
copies DNA/mg protein is needed).

(Optional) Comments

Note: The software calculates the mass (g) and % recovery.

resDNASEQ™ Quantitative DNA Kits User Guide 41



Chapter 3 Plasmid DNA quantitation
| D | Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument
Samples (24) Add
Spike Volume  Spike Standard Concentratior :
0.00 0.00
0.00 0.00

0.00 0.00

O— »

@ Textbox—type in the value, or use the up and down arrows
@ Scroll bar—scroll to find the spike parameter
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Figure 11 Quantitative Kanamycin template default sample plate layout
(D Toolbar (in order: O Undo, C Redo, (7] Copy, Il Paste, € Delete, @View)
@ Select Item to highlight (Sample, Target, or Task).

Note: If more samples are added, the Target displays as an S in the wells (experiment type—Quantitation).
@ Select Item. For example, Sample 1. Sample 1 replicates are highlighted.
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Table 16 Plate well descriptions

Name Description
SC1 to SC6 Standard curve dilutions in triplicate
X1 to X3, D1 to D4 24 samples in triplicate
NTC No template control in triplicate

8. (Optional) Double-click wells to add comments. Comments can also be added post-analysis.

Comments

B Sampled B Samplein B

9. Click Next.
The Run screen is displayed.

10. Experiments are auto-saved in the software. To save, exit the experiment. The software prompts
you to save changes. Click Yes.

Note: Clicking B Save As creates a copy of the experiment.

11. (Optional) Click "= Print to print the plate layout for use in preparing the reactions.

12. Assemble the PCR reactions using the instructions of the manufacturer for the reagents and
following the plate layout set up in the template.
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Start the run

Start the run in the AccuSEQ™ Software.

Option

Description

If the experiment is open

Click Start Run.

If the experiment is closed

o

Open the experiment.
Click the Run tab.
Click Start Run.
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A message stating Run has been started successfully is displayed when the run has started.
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Analyze the results

After the gPCR run is finished, use the following general procedure to analyze the results.
For more detailed instructions see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).

1. In the AccuSEQ™ Real-Time PCR Software, open the experiment, then navigate to the Result tab.

AccuSEQ” ? C%

/ﬁ\ Setup Run Result Report Audit & E-Sign £} Analysis Settings Save As Save As Template  [3» Export Experiment
Experiment Name : 2019-09-23_6503_CHO_ResDNA_QS5-1 E-Sign Status : Unsigned Assay Name : ResDNA_65td
Result Summary Result Analysis
Plots & Summary Results
-
¥ & i N g Sample v = @|
Amplification Multicomponent Raw Data Standard Curve | Qc Sum 5 5 5 0 e = e 0 5 ] - -
— — — NTC B [nTcE  NTCE so.®@ stpoM sT0M
L3 QHQ‘Q|XHZH Targets ~ H-ﬂ”\i| Al@Es | ms m B B~ B-
L — S | el | e | s
o o a a o
Amplification Plot TsoN |TsoN Ts0M w0 Ee0 6a
e _ - e |2 3 2 E: E EH-
de
S m- @ @ e | e
W S STD.E | sTDE sTDE
4 / ye. ® E: E: E-
Z 20 20 )
7 cr cr cr
Az ST# | sTD# ST S
v E- B B-*
3 3 3
o o cr
4 STD.E |sTDE  sTD.E
€ E: E: E-
/ 4 0s [ es | o3
4 § i = ar cr
i y f i '} Ts1 @ Ts1@ 751 M@ sTo.M sTDM sTOM
i / FlEs B E E- E- B-*
‘ 25 25 25 003 | o3 | oo
4 ce cr cr o cr cr
Ts28 7528 TS2m
o1 ¢l W @
f 23 22 23
\ W ! Ce- | cr
f N | Ts3® Ts3am Ts3m
N J y v @es @ @
o. 0. o.
s + :
wells: [B]33 [N]3 [E]18 63 Empty 0%
‘ Analyse | E-Sign

(D Result tab

@ Analysis Settings

(3 Plot horizontal scrollbar
@ Analyze button

2. In the Result Analysis tab, review the Amplification Curve plots for amplification profiles in the
controls, samples, and the standard curve. Ensure that auto threshold is selected.

Note: For AccuSEQ™ Real-Time PCR Software v3.1 Plasmid- KanR assay only, ensure that the
threshold was set to 0.04 for Kanamycin target and 0.02 for IPC.

3. In the Result Analysis tab, review the QC Summary for any flags in wells.
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Chapter 3 Plasmid DNA quantitation
Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

4.

In the Result Analysis tab, review the Standard Curve plot. Verify the values for the Slope,
Y-intercept, R2, and Efficiency.

Note: The Standard Curve efficiency should be between 90-110% and the R2>0.99. If these
criteria are not met, up to two points, not in the same triplicate, can be removed from the standard
curve data, and the analysis repeated.

(Optional) Navigate to the Report tab to generate a report of the experiment, or to export results.

(Optional for AccuSEQ™ Real-Time PCR Software v3.1) To manually convert the copy number
output to a mass measurement, multiply the copy number given by the AccuSEQ™ Real-Time PCR
Software to the average molecular weight of the plasmid, then divide by the Avogadro constant.

Copy number x Molecular weight (gmol~1)
6.0221 X 1023 mol-1

Mass (g) =

Note: AccuSEQ™ Real-Time PCR Software v3.2 and later calculates mass (g) and % Recovery for
the Quantitative Kanamycin template in the Results table.
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Troubleshooting

Observation

Possible cause

Action

Slope for the standard
curve is outside the
typical range, or Ry
value is significantly
less than 0.99

When applying detectors for
standards, the Task and
Quantity were applied to the
wrong detector.

or

The incorrect Quantity was
entered.

or
Adjust baseline settings.
or

Poor standard curve
preparation technique (forgot
to mix, inaccurate pipetting).

In the SDS software, from the plate document,
double-click a well containing a DNA standard to
view the Well Inspector.

Ensure that the correct Task and Quantity are
applied to the correct detector, then reanalyze.

. Compare std curve statistics using autobaseline or

manual baseline. The upper limit of the manual
baseline setting must be 2 cycles before uptick in
amplification. Verify in Rn vs C; linear view.

A Rn and C; values
are inconsistent with
replicates

Evaporation of reaction
mixture from some wells
occurred because the optical
adhesive cover was not
correctly sealed to the reaction
plate or due to over-drying the
eluates in PrepSEQ™.

. Select the Component tab. Confirm that affected

wells generated significantly less fluorescence than
unaffected replicates.

. Check the amount of solution in each well of the

reaction plate. Confirm that the wells affected by
evaporation contained less solution than unaffected
wells, and corresponded with the inconsistent
results.

For subsequent runs, ensure that the optical
adhesive cover is correctly sealed to the reaction
plate.

Incorrect volume of PCR
reaction mix was added to
some reactions.

. Select the Component tab. Confirm that affected

wells generated significantly less fluorescence than
unaffected replicates.

. Select the Spectra tab. Confirm that the wells with

the incorrect volume of PCR reaction mix generated
significantly different amounts of fluorescence than
the unaffected wells.

For subsequent runs, ensure the correct volume of
PCR reaction mix.

Jagged amplification
plots

Weak lamp or incorrect
replacement.

Replace the lamp or ensure that the existing replacement

is correct.
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Appendix A Troubleshooting
Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real-Time PCR Instrument

(continued)
Observation Possible cause Action
No defined An incorrect detector was 1. Ensure that the correct detector was selected on the

amplification plots

selected on the amplification
plot.

or

An incorrect detector was
applied to the reactions when

setting up the plate document.

amplification plot.

2. If the correct detector was not selected, then in
the plate document, double-click a well to view the
Well Inspector, verify that the detector settings are
correct, and reanalyze.

Abnormal ARn values
or negative AR, values

Incorrect passive reference
was selected when setting up
the plate document.

1. From the plate document, double-click a well to
view the Well Inspector.

2. Ensure that ROX™ dye was selected as the Passive
Reference.

Standard curve for
plasmid DNA assays
is outside of the 90-
110% efficiency range

Incomplete vortexing of low
level standards.

Wide variance of C;
values of plasmid DNA
samples

Incomplete vortexing of
samples.

Repeat reactions, ensuring that samples and standards
are vortexed for 15-30 seconds.
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Use the kit with the 7500 Fast
Real-Time PCR Instrument and
AccuSEQ™ software v2.x

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

ltem Source
Instrument
7500 Fast Real-Time PCR System with AccuSEQ™ software v2.x Contact your local sales
representative
Generic consumables
Disposable gloves MLS
Aerosol-resistant pipette tips MLS
Pipettors: MLS

* Positive-displacement
* Air-displacement

* Multichannel

Consumables for the 7500 Fast Real-Time PCR System

MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL, 20 4346906
plates; for use with 7500 Fast Real-Time PCR System

MicroAmp™ Optical 96-Well Reaction Plate with Barcode & Optical Adhesive 4314320
Films, 100 plates with covers

MicroAmp™ Optical 8-Cap Strips, 300 strips 4323032
MicroAmp™ Optical Adhesive Film Kit, 20 covers, 1 applicator, 1 optical cover 4313663

compression pad

MicroAmp™ Optical Adhesive Film 4360954
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Appendix B Use the kit with the 7500 Fast Real-Time PCR Instrument and AccuSEQ™ software v2.x
Create a plate layout in the AccuSEQ™ v2.0 or v2.1 software

Create a plate layout in the AccuSEQ™ v2.0 or v2.1 software

Note: AccuSEQ™ Software v2.2 or later has factory default SEQ Experiments for the Quantitative
Sf9 and Baculovirus DNA and Quantitative Kanamycin Assays, see “Create a Quantitative Sf9 and
Baculovirus DNA Assay experiment” on page 53 and “Create a Quantitative Kanamycin Assay
experiment” on page 56.

Use this workflow for Quantitative Sf9 and Baculovirus DNA and Quantitative Kanamycin Assays in
AccuSEQ™ Software v2.0 or v2.1.

1. In the home screen, select Create Custom Experiment.

2. In the Experiment name field, enter a unique name for the experiment.

w

Specify experiment information.
a. Select experiment type Quantitation - Standard Curve.

b. Select reagents TagMan™ Reagents.

c. Select ramp speed Standard.

>

In the Plate Setup screen, select the Define Targets and Samples tab.

o

Specify target information.
a. Click Add New Target.

b. Enter a host cell name in the target name field.

c. Select reporter FAM™ dye and quencher NFQ_MGB dye.

Note: For the Sf9 and Baculovirus assay, select reporter VIC™ dye for the Sf9 target and
quencher NFQ_MGB dye. Add an additional target, and select reporter FAM™ dye for the
baculovirus target and quencher NFQ_MGB dye.

d. Select a color for this target.

6. Specify IPC target information.
a. Click Add New Target.

b. Enter IPC in the target name field.

c. Select reporter VIC™ dye and quencher NFQ_MGB dye.

Note: For the Sf9 and Baculovirus assay and the Plasmid DNA - Kanamycin Resistance
assay, select the reporter NED™ dye and quencher NFQ_MGB dye.

d. Select a color for this target.

7. Define new samples.
a. Click Add New Sample.
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10.

11.

12.

Appendix B Use the kit with the 7500 Fast Real-Time PCR Instrument and AccuSEQ™ software v2.x
Create a plate layout in the AccuSEQ™ v2.0 or v2.1 software

b. In Sample Name, add the names of the samples you want to define.
c. Click Next, or select the Assign Targets and Samples tab.

In the Assign Targets and Samples tab, define new targets.

a. Follow the instructions in the top of the tab to set up the standards, unknowns, and negative
controls.

b. Click Define and Set Up Standards to open the Define and Set Up Standards dialog box to
enter the appropriate settings and define the standard curve. When defined, click Apply and
Close. The new standard curve is applied to the plate layout screen.

Assign the IPC to the standard curve wells.

In the Run Method screen, in the Graphical View tab.
a. In Reaction Volume Per Well, enter 30 pL

b. Right-click the left column named Holding Stage 1 and select Delete Selected. This 50°C
hold stage is not needed.

Click the Analysis button in the left panel. In the Analysis Settings window on the right, set the
default settings.

a. On the Ct Settings tab, click Edit Default Settings. Then set Threshold to 0.2, set to
Automatic Baseline, and then click Save Changes.

Note: For CHO samples, a manual baseline of 3-12 is more appropriate.

For the Plasmid DNA - Kanamycin Resistance assay, do not use the default settings. Set the
threshold to 0.04 for KanR and 0.02 for IPC.

b. Select (highlight) both targets.
c. In the right-hand window, select Use Default Settings.

d. Click Apply Analysis Settings.

Note: You can analyze the assays using Automatic or Manual Baseline, use the setting that yields
the best standard curve. For CHO, the upper limit threshold for manual baseline analysis is 12.

Select File » Save as, ensure that the file is named “resDNA_Template”, then select Save as a
template file in the dropdown list and close the template plate document.

Note: You can reuse the plate template document to run an assay by opening the template file
and choosing Save As to save the file with the experiment name.
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Run the plate

52

Note: AccuSEQ™ Software v2.2 or later has factory default SEQ Experiments for the Quantitative
Sf9 and Baculovirus DNA and Quantitative Kanamycin Assays, see “Create a Quantitative Sf9 and
Baculovirus DNA Assay experiment” on page 53 and “Create a Quantitative Kanamycin Assay
experiment” on page 56.

Use this workflow for Quantitative Sf9 and Baculovirus DNA and Quantitative Kanamycin Assays in
AccuSEQ™ Software v2.0 or v2.1.

1. In the toolbar, select File » Open, navigate to the resDNA_Template file, then click Open.

2. In the Experiment Name field, enter the appropriate experiment name, then click Finish.

3. Make any necessary changes to the test sample labels.

Sample Volume —not needed; leave as default (0).
Spike Volume —volume of DNA added to the PCR (set to 10).
Spike Standard Concentration—expected spike amount per reaction (for example, 10 pg).

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

Spike Input—automatically calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected pg spike per PCR reaction.

4. Select Save As to save the new experiment as an EDS experiment file with the same name as
entered in the Experiment Name field.

5. Load the plate into the instrument.

6. Click Start Run.

7. Select a run screen (Amplification plot, Temperature plot, or Run method) to monitor the
progress of the run.

resDNASEQ™ Quantitative DNA Kits User Guide



Appendix B Use the kit with the 7500 Fast Real-Time PCR Instrument and AccuSEQ™ software v2.x
Create a Quantitative Sf9 and Baculovirus DNA Assay experiment

Create a Quantitative Sf9 and Baculovirus DNA Assay
experiment

Note: The Quantitative Sf9 and Baculovirus DNA Assay SEQ experiment is available with AccuSEQ™
Software v2.2 or later.

1. Click Create SEQ Experiment in the home screen.

2. Select Quantitative Sf9 and Baculovirus DNA Assay from the assay list, then click Next .
The Plate Setup screen opens.

3. In the Experiment Menu navigation bar, click Experiment Properties.

4. Enter the experiment name.

Note: The experiment name can be up to 100 letters and numbers. Spaces are not allowed.

5. (Optional) Enter a plate barcode and comments.
6. In the Experiment Menu navigation bar, click Plate Setup.
7. In the Define Samples pane of the Define Targets and Samples tab of the Plate Setup pane,

enter the sample name and the sample dilution. Sample volume is not needed. Click Add New
Sample to add more samples if needed.

IMPORTANT! Do not change the Targets.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Sample Name Dilution Factor = Sample Volume @ Spike Volume | Spike £
SC5 1.0 0.0 0.0

SC6 1.0 0.0 0.0

NTC 1.0 0.0 0.0

Matrix D1_EW1 1.0} 0.0 0.0

Matrix D2_EW1 1.0 0.0 0.0

Matrix D3_EWA1 1.0 0.0 0.0

For information about adding and defining samples, see AccuSEQ™ Real-Time PCR Software v2.2
User Guide (Pub. No. MAN0029201)
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8. In the Define Samples pane in the Define Targets and Samples tab, scroll to the right, then enter
the spike information.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Spike Volume Spike Standard Concentration  Reference Spike Input  Color  Number

0.0 [No Refer... 0.0
0.0 0.0 [No Refer... ~ 0.04 v
0.0 0.0 [No Refer... ~ 0.0}
0.0 0.0 [No Refer... ~ 0.0 v
0.0 0.0 [No Refer... ~ 0.0§
0.0 0.0 |No Refer... 0.0 v

¢ Sample Volume —not needed; leave as default (0).
* Spike Volume—volume of DNA added to the PCR (set to 10).
¢ Spike Standard Concentration—expected spike amount per reaction (for example, 10 pg).

* Reference—the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

* Spike Input—-calculated (double check if correct).

Note: If not correct, ensure Spike Volume value is set to 10 and Spike Standard
Concentration value is the expected pg spike per PCR reaction.

® (Optional) Comments

* Protein Concentration—Drug substance protein concentration (if Total DNA in
pg DNA/mg Protein is needed).

Note: The software calculates the pg of DNA in the initial sample and the percentage of recovered
DNA
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Create a Quantitative Sf9 and Baculovirus DNA Assay experiment

9. Click the Assign Targets and Samples tab.

The default plate layout is shown.

1 AccuSEQ™ Real-Time PCR Detection Software v2.2 - Administrator
File Edit Instument Analysis Tools SAE Help

[2] New Experiment » 5 Open.. |kl Save - £ Close | 4@ Export.. = Print Report.. i

Menu< | Experi : Untitled Type: Standard Curve Reagents: TagMan® Reagents @)
Define Targets and Sarmples T Assign Targets and Samples 1
. . T set up standards: Click "Define and Set Up Standards.
Experiment Properties n Instructions:  To setup unknowns: Select wells, assign target(s), select"U” (Unknown) as the task for each target assignment, then assign a sample.
To set up negative controls: Select wells, assign target(s), then select"N" (Negative Control) as the task for each target assignment.
Plate Setup Assign target(s) to the selected wells. <| Plate Layout | Table View
>
Select Wells With: - Selectitem - ~ | |- Selectltem -
Run Method Assign Target Task Quantity
o [] SF9 STANDA.. ~ 3,000) | [8 | show in wells v | [FE view Legena ‘ | B | B |
Reaction Setup
a BAC STANDA.. 3,000
[+ [ =z | = [ 4 [ 5 [ & [ 7 [ 8 [ & [ 10 [ 1 [ 11 |
IPC UNKNOWN ~
ERUH e Hesc |Heac [Heao [Meac  [eac  [oac  [Meac  [@eac  [Meac  [eac  [Jeac  [oac
e E— Alfec |[@wec Mwee Mee Mrec Dee [[@ec e [@ee  ©ec  @ee  @irc
F Analysis — — - - - - - - - - - -
e B p—— e  [leac  [Fleac  [Meac [Meac  [Meac  [Meac  [Meac  [Meac  [Meac  [Meac  [Meac
l' i Audit & E-Sig wixed [T unknown [5] standard [1] Negative Contral 8 | ec M e [ e IPe. Pc @ e I e [ re IPe M e @ e [ e
o|Hme Hoe Hew Mo Mo Mo Mo Mo Mo Mo Mo Don
‘\\1 — il EIPC glrc gwc IPC IPC EIPC glr’c EIPC IPC gwc glrc gwc
= || |Fleac [Eeac [FHeac Meac Meac [Meac [Meac  [Meac  [Meac  [Meac  [Meac  [Meac
Assign sample(s) to the selected wells. e [ ec e e Pe s e [ wee [Mee Pe [Mwec [Mwec e
sssign sample Heae [[Heac [Heac [Meac [Meac [eac  [Meac  [eac  [eac  [Meac  |[Meac  [Meac
® | sot | fldee e @re e we  [Mec |[@drec e we  Mec |[@ec e
] sc2 Mesc  [Meac [Meac  [Merc  [eac  [oac  [Meac  [eac  [sac  [Meac  [eac  [Moac
O s Fldee |dec e P we  Mec [@dree e we  Mec [@ree e
0 |scs o mc  [Merc |[[Meac  [Merc mc  [Merc |[[Merc [Meac
a — ° irc we  Mec e e re  Mee Hree e
Select the dye to use as the passive reference. [deac [Oeac  [Osac  [Meac  [[eac  [Msac  [Meac  [@oac  [Meac  [Meac  [eac  [Msac
HiOee e [Dwee [@ee [ee [Mec [Mee e [@wee @ec  |Eec e
ROX “ - - - - - = = - - - = =
wells: [ 90 Unknown [] 15 Standard [] 3 Negative Contral 3 Empty
«
A Home | [ Untitied % |
Disconnected
|

Table 17 Plate well descriptions

Name

Description

SC1 to SC6 Standard curve dilutions in triplicate

Matrix 3 samples in 6 matrices

NTC No template control in triplicate

10. (Optional) Edit the plate.

To change the plate layout display, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide (Pub.

No. MAN0029201).

a. Assign the targets to wells in the plate layout.

b. Assign samples to wells in the plate layout.

11. Confirm that ROX™ dye is selected as the passive reference.

12. (Optional) Save the plate layout as an image.

a. Right-click the plate layout.

b. Select Save As.
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13.

14.

15.

16.

17.

c. Specify a file name and location for the JPEG file, then click Save.

Note: Electronic signature information is not included in an image file. Use Print Report to
include Electronic signature information with the plate layout.

(Optional) Print the plate layout
a. Right-click the plate layout.

b. Click Print Preview or Print.
In the Experiment Menu navigation bar, click Run Method.

In the Run Method screen, view the default volume and cycling conditions.

IMPORTANT! Do not modify the run method for factory default SEQ experiments.

In the Experiment Menu navigation bar, click Reaction Setup.

In the Reaction Setup screen, complete the reaction setup, see AccuSEQ™ Real-Time PCR
Software v2.2 User Guide (Pub. No. MAN0029201).

Assemble the PCR reactions using the instructions of the manufacturer for the reagents and
following the plate layout.

Create a Quantitative Kanamycin Assay experiment

56

Note: The Quantitative Kanamycin Assay SEQ experiment is available with AccuSEQ™ Software v2.2
or later.

1.

2.

Click Create SEQ Experiment in the home screen.

Select Quantitative Kanamycin Assay from the assay list, then click Next .
The Plate Setup screen opens.

In the Experiment Menu navigation bar, click Experiment Properties.

Enter the experiment name.

Note: The experiment name can be up to 100 letters and numbers. Spaces are not allowed.

(Optional) Enter a plate barcode and comments.
In the Experiment Menu navigation bar, click Plate Setup.

In the Define Targets pane of the Define Targets and Samples pane, enter the molecular weight
(g/mol) of the targets to calculate mass (g) in the results.

IMPORTANT! Do not change the Targets.
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Create a Quantitative Kanamycin Assay experiment

Define Targets for plate setup

Add New Target l Add Saved Target l Save Target | Delete Target

Target Name Reporter Quencher Color Molecular Wei...
Kan |Fam v |NFomGB v v
IPC NED ~ |INFQ-MGB v ~ [10.0

8. In the Define Samples pane of the Define Targets and Samples tab of the Plate Setup pane,
enter the sample name and the sample dilution. Sample volume is not needed. Click Add New
Sample to add more samples if needed.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Sample Name Dilution Factor ~ Sample Volume = Spike Volume | Spike £
§C5 1.0 0.0 0.0

SC6 1.0 0.0 0.0

NTC 1.0 0.0 0.0

Matrix D1_EW1 0.0 0.0

Matrix D2_EW1 1.0 0.0 0.0

Matrix D3_EW1 1.0 0.0 0.0

For information about adding and defining samples, see AccuSEQ™ Real-Time PCR Software v2.2
User Guide (Pub. No. MAN0029201).
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9.

In the Define Samples pane in the Define Targets and Samples tab, scroll to the right, then enter
the spike information.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Spike Volume Spike Standard Concentration  Reference Spike Input  Color  Number

0.0 [No Refer... 0.0
0.0 0.0 [No Refer... ~ 0.04 v
0.0 0.0 [No Refer... ~ 0.0}
0.0 0.0 [No Refer... ~ 0.0 v
0.0 0.0 [No Refer... ~ 0.0§
0.0 0.0 |[No Refer... ~ 0.0 =

Sample Volume —not needed; leave as default (0).
Spike Volume —volume of DNA added to the PCR (set to 10).

Spike Standard Concentration—expected spike amount per reaction (for example,

10 copies).

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

Spike Input—calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected copies spike per PCR reaction.

Protein Concentration —Drug substance protein concentration (if total DNA in
copies DNA/mg protein is needed).

(Optional) Comments

Note: The software calculates the mass (g) and % recovery in the Table View tab of the Analysis
screen.
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10. Click the Assign Targets and Samples tab.
The default plate layout is shown.

| 3 AccuSEQ™ Real-Time PCR Detection Software v2.2 - Administrator - o X
File Edt Instument Anabsis Tools SAE Help
[2] New Experiment » 5 Open.. |kl Save - £ Close | 4@ Export.. = Print Report.. i

Menu< | Experi : Untitled Type: Standard Curve Reagents: TagMan® Reagents @)

Define Targets and Sarmples T Assign Targets and Samples 1

. . T set up standards: Click "Define and Set Up Standards.
Experiment Properties n Instructions:  To setup unknowns: Select wells, assign target(s), select"U” (Unknown) as the task for each target assignment, then assign a sample.
To set up negative controls: Select wells, assign target(s), then select "N (Negative Control) as the task for each target assignment

Run Method ? Select Wells With: |- Selectltem - | |- Select Item -
Assign | Targst Task Quantity
o [] | Kan ‘STANDA v‘ ann,nun| | [8 | show in wells v | [FE view Legena ‘ | B | B |
Reaction Setup
a | IPC ‘UNKNDWN v‘
| [+ [ =z | = [ 4 [ 5 [ & [ 7 [ 8 [ & | 10 | 1 [ 11 |
Run Xfs EWI | Xfs EWI | Xia EW! | Xis EW2 | Xis EW2 | Xia EWZ | Xis EW3 | Xis EW3 | Xia EW3
H Al ec @ec  @re  mec e e we  [Mwc [wec [@wec [rc [@re
E- Analysis He He B mam men mee M mee e mee mes  mes
[ me |[mee W .xz.Eww .xanw\ Eﬁz.m mxzaswz mxzaswz .xz.Ewl mxz-swa m;(zazwa mxzaswa
= n = = B [ ec [ ec 23 PC Irc [ ec Irc PC 1rc
t' i Audit & E-Sig Mixed [ Unknown [5] Standard [] Negative Gontrol [ kan Elkan  [Elkan =P = Mlen =N Ml ien =P =P e e
[ X3 EW1 X3a EW1 X3a EW1 X3a EW2 X3a EW2 X3 EWZ2 X3a EW3 X3a EW3 X3a EW3
o|@wec  @ee  @re  mec' @ec Dec @ee e Dwee  Dec  |@ee [ee
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Name Description

SC1 to SC6 Standard curve dilutions in triplicate

X1 to X3, D1 to D4 24 samples in triplicate

NTC No template control in triplicate

11. (Optional) Edit the plate.

To change the plate layout display, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide (Pub.
No. MAN0029201).

a. Assign the targets to wells in the plate layout.
b. Assign samples to wells in the plate layout.
12. Confirm that ROX™ dye is selected as the passive reference.

13. (Optional) Save the plate layout as an image.
a. Right-click the plate layout.

b. Select Save As.
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Run and monitor an experiment

14.

15.

16.

17.

18.

c. Specify a file name and location for the JPEG file, then click Save.

Note: Electronic signature information is not included in an image file. Use Print Report to
include Electronic signature information with the plate layout.

(Optional) Print the plate layout
a. Right-click the plate layout.

b. Click Print Preview or Print.
In the Experiment Menu navigation bar, click Run Method.

In the Run Method screen, view the default volume and cycling conditions.

IMPORTANT! Do not modify the run method for factory default SEQ experiments.

In the Experiment Menu navigation bar, click Reaction Setup.

In the Reaction Setup screen, complete the reaction setup, see AccuSEQ™ Real-Time PCR
Software v2.2 User Guide (Pub. No. MAN0029201).

Assemble the PCR reactions using the instructions of the manufacturer for the reagents and
following the plate layout set up in the template.

Run and monitor an experiment

60

To load and start the instrument, see Applied Biosystems™ 7300/7500/7500 Fast Real-Time PCR
System Getting Started Guide: Absolute Quantitation using Standard Curve (Pub. No. 4347825).

At the top of every run screen, the run status is shown.

During an experiment run, progress bars reflect run status. During the third stage of a the experiment,
there is a delay between melting and completion of the third stage during which the system analyzes

the data.
1. In the experiment menu, select Run.
2. If the run is not already in progress, click Start Run.
3. If the run is in progress, select a run screen from the navigation pane to monitor the progress.

* Amplification Plot-Select to view the change in normalized reporter signal (ARn) for each
cycle.

Note: Shown only for experiments with amplification.

* Temperature Plot-Select to view the temperature (°C) plotted against time.
* Run Method-Select to view the run method status during the instrument run.

To modify the plots in the Run screen, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide
(Pub. No. MAN0029201).
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Appendix B Use the kit with the 7500 Fast Real-Time PCR Instrument and AccuSEQ™ software v2.x
Analyze the results

4. (Optional) Click Stop Run at the top-left of the run screen to stop the run.
If the computer is connected to the instrument, the software can stop the instrument run.

IMPORTANT! You cannot resume a run after you stop it.

Analyze the results

After the run is finished, use the following general procedure to analyze the results:

1. In the toolbar, select Analysis » Analysis Settings.
2. Click (Analyze).
3. Select Analysis » QC Summary in the left panel of the screen. Review the flag summary.

4. In the left panel, select Analysis » Standard Curve. Verify the values for the Slope, Y-Intercept, R2,
and Efficiency.

5. Select File » Print Report to generate a hardcopy of the experiment, or click Print Preview to view
and save the report as a PDF or HTML file.

6. Optional: Select File » Export. In the Export Data menu, select file type *.xls. Click Start Export.
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Use the kit with 7500 System SDS

Software v1.5.1

Create the plate document, run the plate, and analyze the
results with 7500 Fast SDS software

The following instructions apply only to the Applied Biosystems™ 7500 Fast instrument with SDS v1.x
software. If you use a different instrument or software, refer to the applicable instrument or software
documentation. Genomic residual DNA is measured in concentration, while plasmid residual DNA is
measured in copy number.

Create a plate document

Residual DNA assays are duplex assays, containing sample DNA and Internal Positive Control (IPC).

Plate document: settings

If you have run the assay frequently, you can use the table below to enter settings in Plate Document
fields. If you are a new user, follow the detailed instructions in the following sections.

Summary of settings for the Plate Document

In this field...

Use these settings

Detector

resDNASEQ™ kit target cell
lines

* Single target assays: FAM™ dye
® Sf9 and Baculovirus assay: VIC™ and FAM™ dyes

(Select NFQ_MGB dye for quencher)

IPC

* Single target assays: VIC™ dye

® Sf9 and Baculovirus assay and Plasmid DNA - Kanamycin
Resistance assay: NED™ dye

(Select NFQ_MGB for quencher)

PCR

Hold

Temp: 95°C
Time: 10:00
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Appendix C Use the kit with 7500 System SDS Software v1.5.1

Create the plate document, run the plate, and analyze the results with 7500 Fast SDS software

(continued)

Summary of settings for the Plate Document

In this field...

Use these settings

PCR Cycling (Standard Mode) Cycles: 40

Temp: 95°C Time: 0:15
Temp: 60°C Time: 1:00

Analysis | CHO, E. coli, HEK293, Human, | Automatic Baseline or Manual Baseline!!
MDCK, NSO, Pichia, Plasmid
DNA - Kanamycin resistance,
Sf9 and Baculovirus, and Vero | Note: For CHO, the upper limit for manual baseline analysis is

Threshold: 0.2

12.
For the Plasmid DNA - Kanamycin Resistance assay, change the
threshold to 0.04 for KanR and 0.02 for IPC.

' You can analyze the assay using Automatic or Manual Baseline, use the setting that yields the best standard curve.

Plate document: procedure

Use the SDS v1.x software on the Applied Biosystems™ 7500 Fast instrument to perform this

procedure.

1. In the template Assay dropdown list, select Absolute Quantification.

2. In the Run Mode dropdown list, select Standard 7500.

3. Enter resDNA_Template in the Plate name field, then click Next.

4. Click New Detector:

a. Enter the name of the target cell line in the Name field.

b. Select reporter FAM™ dye and quencher NFQ_MGB dye.

Note: For the Sf9 and Baculovirus assay, select reporter VIC™ dye for the Sf9 target and
quencher NFQ_MGB dye. Add an additional target, and select reporter FAM™ dye for the
baculovirus target and quencher NFQ_MGB dye.

c. Select a color for the detector, then click Create Another.

5. Click New Detector:

a. Enter IPC in the Name field.

b. Select reporter VIC™ dye and quencher NFQ_MGB dye.

Note: For the Sf9 and Baculovirus assay and the Plasmid DNA - Kanamycin Resistance
assay, select the reporter NED™ dye and the quencher NFQ_MGB dye.

c. Select a color for the detector, then click OK.
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Appendix C Use the kit with 7500 System SDS Software v1.5.1
Create the plate document, run the plate, and analyze the results with 7500 Fast SDS software

d. Select the detectors, then click Add>> to add the detectors to the document (plate).

6. Select ROX™ dye as the passive reference dye, then click Next.

7. Select the applicable set of wells for the samples, then select the target cell line and IPC detectors

for each well. The following figure shows an example plate layout:

Standard Curve (pg)
1 2 3 5 6 7 8|9 10 11 12
A| TS TS TS TS1 ERC TS1 ERC TS1 ERC NTC NTC NTC
B| TS2 | TS2 | TS2 TS2 ERC | TS2ERC | TS2 ERC
C| TS3 | TS3 | TS3 TS3ERC | TS3ERC | TS3ERC 0.03 pg 0.03 pg 0.03 pg
D 0.3 pg 0.3 pg 0.3 pg
E 3 pg 3 pg 3pg
F | NEG | NEG | NEG 30 pg 30 pg 30 pg
G 300 pg 300 pg 300 pg
H 3,000 pg 3,000 pg 3,000 pg
8. Set tasks for each sample type by clicking on the Task Column dropdown list:
a. NTC: target cell line detector task = NTC
b. NEG, test samples, and ERC wells: target DNA detector task = Unknown
c. IPC = Unknown for all wells
9. Set up the standard curve:
a. Select the wells.
b. Assign the tasks (target DNA = Standard) and enter the appropriate Quantity for each set of
triplicates.
Tube label Row-wells Task Quantity | Label (pg)
SD 1 H-10, 11, 12 | Standard 3,000 3,000 pg
SD 2 G-10, 11, 12 | Standard 300 300 pg
SD3 F-10, 11,12 | Standard 30 30 pg
SD 4 E-10, 11, 12 | Standard 3 3 pg
SD5 D-10, 11, 12 | Standard 0.3 0.3 pg
SD 6 (for CHO, Vero, MDCK, and NSO only) C-10, 11, 12 | Standard 0.03 0.03 pg
Note: The Plasmid DNA - Kanamycin Resistance assay creates a standard curve based on
copy number (300,000 to 30 copies per reaction).
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Appendix C Use the kit with 7500 System SDS Software v1.5.1
Create the plate document, run the plate, and analyze the results with 7500 Fast SDS software

10. Select the Instrument tab, then set thermal-cycling conditions:
* Set the thermal cycling reaction volume to 30 L.
* Set the reaction to Standard Mode.
* Set the temperature and the time as shown in the following table:

Step AmpliTag Gold™ enzyme activation PCR

Hold Cycle (40 Cycles)

Denature Anneal/extend

Temp (°C) 95 95 60

Time (mm:sec) 10:00 0:15 1:00

Refer to the applicable 7500 Fast Real-Time PCR Systems instrument manual for additional
information.

11. In the Analysis Settings window, enter the following settings, then click OK:
a. Select Manual Ct.

b. In Threshold, enter 0.2.

Note: For the Plasmid DNA - Kanamycin Resistance assay, change the threshold to 0.04 for
KanR and 0.02 for IPC.

c. Select Automatic Baseline or Manual Baseline.

Note: You can analyze the assays using Automatic or Manual Baseline, use the setting that yields
the best standard curve. For CHO, the upper limit threshold for manual baseline analysis is 12.

12. Select File » Save as, confirm that the file is named “resDNA_Template”, then select SDS
Templates (*.sdt) in the Save as type dropdown list and close the template plate document.

Note: You can reuse the plate template document whenever you run the assay.

13. Close the saved template file.

Run the plate

1. In the SDS software, select File » New, navigate to the resDNA_Template file (created in “Plate
document: procedure” on page 63), then click Open.

2. In Plate Name, enter an appropriate experiment name, then click Finish.
3. Make any necessary changes to the test sample labels.

4. Select Save As to save the new experiment as an SDS experiment file.
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Create the plate document, run the plate, and analyze the results with 7500 Fast SDS software

5.

6.

Load the plate on the instrument.

Select the Instrument tab, save the document, then click Start to start the real-time gPCR run.

Analyze the results

66

After the gPCR run is finished, use the following general procedure to analyze the results.

1.

2.

Select the Results tab.

Select the Amplification Plot tab.

Verify the analysis settings, change as appropriate, then click Analyze.

Select the Results tab » Standard Curve tab, then verify the Slope, Intercept, and R2 values.

Right-click the Standard Curve, select Export as JPEG, then click OK. Alternatively, press
PrintScreen, then paste the image in a WordPad file.

Select the Report tab » Report, then review the mean quantity and standard deviation for each
sample.

Optional: Select File » Export » Results. In the Save as type drop-down list, select Results
Export Files (*.csv), then click Save.
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Good laboratory practices

Work area setup and lab design

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute quantities of DNA,
necessitating precautions to avoid contamination of samples yet to be amplified (Kwok and Higuchi,
1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at all times and
change them frequently. Close sample tubes when not in use. Limit aerosol dispersal by handling
sample tubes and reagents carefully.

Good laboratory practices for PCR and RT-PCR

¢ Wear clean gloves and a clean lab coat.

— Do not wear the same gloves and lab coat that you have previously used when handling
amplified products or preparing samples.

* Change gloves if you suspect that they are contaminated.
* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation and reaction setup.
- Amplification and analysis of products.
* Do not bring amplified products into the reaction setup area.
* Open and close all sample tubes carefully. Avoid splashing or spraying samples.
* Keep reactions and components capped as much as possible.
* Use a positive-displacement pipettor or aerosol-resistant barrier pipette tips.

* (Clean lab benches and equipment periodically with 10% bleach solution or DNA decontamination
solution.

Avoiding false positives due to cross-contamination

To avoid false positives due to cross-contamination:
* Do not open tubes after amplification.

* Use different sets of pipettors when pipetting negative control, unknown, and positive control
samples.

Note: Refer to “Prepare the PCR plate” on page 16 for best practice.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, see the “Documentation and Support” section in this document.
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Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-
P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Publication

Reference Card

Document Description
number

resDNASEQ™ Quantitative DNA Kits 4469837 For brief instructions about using the

Quick Reference resDNASEQ™ Quantitative DNA Kits.

resDNASEQ™ Quantitative E1A DNA MANO0025643 For instructions about running the

Fragment Length Kit User Guide resDNASEQ™ Quantitative E1A DNA Fragment
Length Kit (Cat. No. A51969).

PrepSEQ™ Sample Preparation Kits 4469838 For information about preparing samples for

User Guide extraction.

PrepSEQ™ Residual DNA Sample 4469839 For brief instructions about preparing samples

Preparation Kit Quick Reference for extraction.

AccuSEQ™ Real-Time PCR Software 100094287 For information about AccuSEQ™ Real-Time

v3.1 User Guide PCR Software v3.1 with the QuantStudio™ 5
Real-Time PCR System

AccuSEQ™ Real-Time PCR Software 100094288 For basic information about AccuSEQ™

v3.1 Quick Reference Real-Time PCR Software v3.1 with the
QuantStudio™ 5 Real-Time PCR System

AccuSEQ™ Real-Time PCR Software MANO0029199 For information about AccuSEQ™ Real-Time

v3.2 User Guide PCR Software v3.2 with the QuantStudio™ 5
Real-Time PCR System

AccuSEQ™ Real-Time PCR Software MAN0029200 | For pasic information about AccuSEQ™

v3.2 Quick Reference Real-Time PCR Software v3.2 with the
QuantStudio™ 5 Real-Time PCR System

AccuSEQ™ Real-Time PCR Software MANO0029201 For information about AccuSEQ™ Real-Time

v2.2 User Guide PCR Software v2.2 with the 7500 Fast
instrument.

Applied Biosystems™ 7300/7500/7500 4347825 For information about the 7500 Fast

Fast Real-Time PCR System Getting instrument.

Started Guide: Absolute Quantitation

using Standard Curve

AccuSEQ™ software: Custom Quick 4425585 For information about AccuSEQ™ software with

the 7500 Fast instrument.
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Appendix F Documentation and support
Customer and technical support

Customer and technical support

Single Point of Contact Contact Information

Technical Support North America +1 800 955 6288, select option 2, then option 1, then option 2.

techsupport@thermofisher.com

Technical Support Europe, the Middle East, | +00 800 5345 5345

and Africa (EMEA) eurotech@thermofisher.com

Technical Support Asia-Pacific (APAC) Contact your local Thermo Fisher Scientific representative

Visit thermofisher.com/support for the latest service and support information.
¢ Worldwide contact telephone numbers
* Product support information
- Product FAQs
- Software, patches, and updates
— Training for many applications and instruments
* Order and web support
* Product documentation
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.

72 resDNASEQ™ Quantitative DNA Kits User Guide


http://thermofisher.com/support
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/support




thermofisher.com/support | thermofisher.com/askaquestion Thermo Fisher
thermofisher.com SCIENTIFIC

28 July 2023


http://thermofisher.com/support
http://thermofisher.com/askaquestion
http://thermofisher.com

	resDNASEQ Quantitative DNA Kits User Guide (Pub. No. 4469836 L)
	Copyright Page
	Contents
	Chapter 1. Product information
	Product description
	Contents
	Required materials not supplied
	Workflows

	Chapter 2. Genomic DNA quantitation
	Prepare the control DNA serial dilutions for the standard curve
	Guidelines for standard dilutions
	Prepare the control serial dilutions (Genomic DNA)

	Prepare the PCR reaction mix
	Prepare the PCR plate
	Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real‑Time PCR Instrument
	Create a resDNASEQ™ experiment
	Create a Quantitative Sf9 and Baculovirus DNA experiment
	Start the run
	Analyze the results


	Chapter 3. Plasmid DNA quantitation
	Prepare the control DNA serial dilutions for the standard curve
	Guidelines for standard dilutions
	Prepare the control serial dilutions (Plasmid DNA - Kanamycin Resistance)

	Prepare the samples (Kanamycin resistance assay only)
	Prepare the PCR reaction mix
	Prepare the PCR plate
	Setup, run, and analyze samples with AccuSEQ™ Software on the QuantStudio™ 5 Real‑Time PCR Instrument
	Create a resDNASEQ™ template (Plasmid DNA)
	Create a resDNASEQ™ experiment (Plasmid DNA)
	Create a Quantitative Kanamycin experiment
	Start the run
	Analyze the results


	Appendix A. Troubleshooting
	Appendix B. Use the kit with the 7500 Fast Real‑Time PCR Instrument and AccuSEQ™ software v2.x
	Required materials not supplied
	Create a plate layout in the AccuSEQ™ v2.0 or v2.1 software
	Run the plate

	Create a Quantitative Sf9 and Baculovirus DNA Assay experiment
	Create a Quantitative Kanamycin Assay experiment
	Run and monitor an experiment
	Analyze the results

	Appendix C. Use the kit with 7500 System SDS Software v1.5.1
	Create the plate document, run the plate, and analyze the results with 7500 Fast SDS software
	Create a plate document
	Plate document: settings
	Plate document: procedure

	Run the plate
	Analyze the results


	Appendix D. Good laboratory practices
	Work area setup and lab design
	Good laboratory practices for PCR and RT-PCR
	Avoiding false positives due to cross-contamination


	Appendix E. Safety
	Chemical safety
	Biological hazard safety

	Appendix F. Documentation and support
	Related documentation
	Customer and technical support
	Limited product warranty

	Back Cover


